ENTIS R130.2
Installation and Configuration Guide
ABOUT THIS GUIDE

This manual describes how to install and configure the ENTIS system. It has been written for the operators as well as system supervisors to provide them with all the information required to install and configure the system.

Safety and prevention of damage

‘Cautions’, and ‘Notes’ have been used throughout this manual to bring special matters to the immediate attention of the reader.

A Caution draws attention to an action which may damage the equipment.

A Note points out a statement deserving more emphasis than the general text but does not deserve a “Warning” or a “Caution”.

Additional information

Contact Honeywell or its representative if you require additional information. Also, refer to the list of related documents in Documentation References.

Legal aspects

The information in this manual is copyright property of Honeywell. Honeywell disclaims any responsibility for personal injury or damage to equipment caused by:

- Deviation from any of the prescribed procedures
- Execution of activities that are not clearly documented.

Copyright 2023 Honeywell. All rights reserved.

Reproduction in any form without the prior consent of Honeywell is not allowed. This manual is for information only. The contents, descriptions and specifications are subject to change without notice. Honeywell accepts no responsibility for any errors that may appear in this manual. The warranty terms and conditions applicable in the country of purchase in respect to Honeywell products are available from your supplier. Please retain them with your proof of purchase.
Support

For support, contact your local Honeywell Process Solutions Customer Contact Centre (CCC). To find your local CCC visit the website, [https://process.honeywell.com/us/en/contact-us](https://process.honeywell.com/us/en/contact-us)

Revision History

ENTIS Installation and Configuration Guide (This document)

<table>
<thead>
<tr>
<th>Documentation Reference</th>
<th>Revision Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>ETDOC-X613-en-R101A</td>
<td>September 2019 (1st Release)</td>
</tr>
<tr>
<td>ETDOC-X613-en-R110.1</td>
<td>December 2019 (R110.1)</td>
</tr>
<tr>
<td>ETDOC-X613-en-R120.1</td>
<td>June 2020 (R120.1)</td>
</tr>
<tr>
<td>ETDOC-X613-en-R121.1</td>
<td>September 2020 (R121.1)</td>
</tr>
<tr>
<td>ETDOC-X613-en-R121.2</td>
<td>August 2021 (R121.2)</td>
</tr>
<tr>
<td>ETDOC-X613-en-R130.1</td>
<td>December 2022 (R130.1)</td>
</tr>
<tr>
<td>ETDOC-X613-en-R130.2</td>
<td>April 2023 (R130.2)</td>
</tr>
</tbody>
</table>

Documentation References

The following list identifies publications that may contain information relevant to the information in this document.

<table>
<thead>
<tr>
<th>Documentation Reference</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>ETDOC-X612-en-R130.2</td>
<td>ENTIS Quick Start Guide</td>
</tr>
<tr>
<td>ETDOC-X615-en-R130.2</td>
<td>ENTIS User’s Guide</td>
</tr>
<tr>
<td>EPDOC-X136-en-520B</td>
<td>Experion HS Software Installation Users Guide</td>
</tr>
</tbody>
</table>


Contacts

See back page for details
# TABLE OF CONTENTS

1 INTRODUCTION ................................................................................................................................. 1

2 HARDWARE REQUIREMENTS .................................................................................................................. 2

2.1 ENTIS as a Server ............................................................................................................................. 2

2.2 ENTIS as a Client (User Interface) ................................................................................................ 2

2.3 ENTIS as Server / Client on Panel PC ............................................................................................ 2

3 SOFTWARE REQUIREMENTS ................................................................................................................. 1

3.1 Prerequisite Software ....................................................................................................................... 1

3.2 Antivirus Software ........................................................................................................................... 1

4 INSTALLATION OF ENTIS .................................................................................................................... 2

4.1 Prerequisites .................................................................................................................................... 2

4.2 Backup and Restore of Experion HS Data ....................................................................................... 3

4.2.1 BACKUP ................................................................................................................................. 3

4.2.2 RESTORE ............................................................................................................................ 5

4.3 Migrating non redundant ENTIS R121.1 to R130.2 ........................................................................ 5

4.4 Migrating ENTIS R130.1 to R130.2 ............................................................................................... 7

4.4.1 For Non-redundant Server: ...................................................................................................... 7

4.4.2 For redundant server: ............................................................................................................. 7

4.5 Migration Redundant Setup with Single Network .......................................................................... 8

4.6 Installing ENTIS as a Server .......................................................................................................... 9

5 INSTALLING ENTIS WITH REDUNDANCY ...................................................................................... 14

5.1 Non-redundant ............................................................................................................................... 14

5.2 Non-redundant ENTIS Hosting Redundant CIU’s .......................................................................... 15

5.3 Redundant with Single Network .................................................................................................... 16

5.3.1 Prerequisites .......................................................................................................................... 16

5.3.2 Commissioning ..................................................................................................................... 17

5.3.3 Configure arbitration ............................................................................................................. 18

5.4 Configuring ENTIS for File Replication ...................................................................................... 22

5.5 Configuring ENTIS for Data Synchronization .......................................................................... 25

5.6 Configuring Station Connections for Server Redundancy ............................................................ 26

5.6.1 Single-screen stations ............................................................................................................ 26

5.6.2 Multi-screen stations using SafeView ................................................................................... 27

6 INSTALLING ENTIS AS CLIENT (USER INTERFACE) ................................................................. 29

7 INSTALLING ENTIS ON PANEL PC ................................................................................................ 34

8 CHANGING LANGUAGE .................................................................................................................... 35

8.1 ENTIS and Experion HS Server .................................................................................................... 35

8.2 Experion HS Client ....................................................................................................................... 35

9 VERIFYING SUCCESSFUL INSTALLATION .................................................................................... 37

10 CONFIGURING THE ENTIS SYSTEM IN EXPERION ................................................................. 39

10.1 Starting Configuration Studio ...................................................................................................... 39

10.2 Configuring Assets ....................................................................................................................... 44

10.3 Loading Asset Model on to Servers in the System ..................................................................... 48

10.4 Creating FLEX or Client Stations (Multi User) ......................................................................... 51

10.5 ENTIS Multi Screens using SafeView ......................................................................................... 53

10.5.1 Change the resolution / Desktop Area pixels ...................................................................... 53

10.5.2 Verify the Settings ................................................................................................................ 54
10.6 REMOVE OLD TANKS (AND SCADA POINTS) FROM EXPERION ................................................................. 55
10.7 SETTINGS REQUIRED IN EXPERION ........................................................................................................ 59
  10.7.1 Events in Experion ........................................................................................................................... 59
  10.7.2 Alarm sounds and levels on station .................................................................................................. 60
10.8 CONFIGURING HISTORIZATION SETTINGS FOR REAL TIME TRENDING ............................................. 61

11 MIGRATING CIU 888 DATABASE .................................................................................................................. 64
  11.1 Migration using ENTIS Configuration Tool ......................................................................................... 64
  11.2 Sites where Experion channels and controllers are already present ..................................................... 69

12 CONFIGURING SECURE COMMUNICATION OVER OPC UA ....................................................................... 71

13 SETUP EVENT LOGGING SETTINGS ......................................................................................................... 74

14 INSTALLING THE ENTIS LICENSE ......................................................................................................... 75

15 SETTING UP THE PRINTER ....................................................................................................................... 76
  15.1 Scheduled printer installation steps .................................................................................................... 76

16 UNINSTALL ENTIS ..................................................................................................................................... 82

TABLES

Table 2-1: ENTIS as a Server .......................................................................................................................... 2
Table 2-2: ENTIS as a Client .......................................................................................................................... 2
Table 2-3: ENTIS Server / Client on Panel ..................................................................................................... 2
Table 3-1: Software Requirements ................................................................................................................ 1
FIGURES

FIGURE 1: ENTIS SETUP ................................................................................................................................................................. 9
FIGURE 2: NON-REDUNDANT ENTIS TOPOLOGY .......................................................................................................................... 14
FIGURE 3: NON-REDUNDANT ENTIS HOSTING REDUNDANT CIU’S TOPOLOGY ...........................................................................15
FIGURE 4: ENTIS REDUNDANT SINGLE NETWORK TOPOLOGY ...................................................................................................... 16
FIGURE 5: SINGLE NETWORK CONFIGURATION ......................................................................................................................... 17
FIGURE 6: EXPERION COMMAND PROMPTS ............................................................................................................................. 20
FIGURE 7: CONNECTION PROPERTIES ........................................................................................................................................ 26
FIGURE 8: ENTISMULTISCREEN edit Connection Type ................................................................................................................ 27
FIGURE 9: ENTISMULTISCREEN edit Hostnames ............................................................................................................................ 27
FIGURE 10: ENTIS SETUP ......................................................................................................................................................... 29
FIGURE 11: CONNECTION PROPERTIES ..................................................................................................................................... 33
FIGURE 12: SET EXPERION TO DATABASE ONLY MODE ........................................................................................................ 62
FIGURE 13: HISTORY ASSIGNMENT .......................................................................................................................................... 63
1 INTRODUCTION

This guide introduces you to software and hardware requirements, prerequisites, and procedures for installing ENTIS as a server or client system on a physical or virtual machine. This document provides information on how to configure an ENTIS system. It describes how to create Channels, Controllers & Equipment for an ENTIS system using Configuration Studio, and how to download them to an Experion HS server. In addition, it also explains how to export the database from a CIU 888 and how to configure the ENTIS license.

Reference document
1. For more information on using Configuration Studio, refer to Experion HS Configuration Studio Overview, EPDOC-X113-en-520A.
2. For more information on Experion HS, refer to the link below: Product Documents & Downloads (honeywell.com)
2 HARDWARE REQUIREMENTS

The hardware systems (for Physical or Virtual machine) that are recommended for installation and use of ENTIS as a Server and Client on Physical/Virtual machine, or Panel PC are given in the following tables.

2.1 ENTIS as a Server

Table 2-1: ENTIS as a SERVER

<table>
<thead>
<tr>
<th>System Configuration</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Single Intel Xeon Processor E5-1620v3, 3.50GHz (or equivalent)</td>
</tr>
<tr>
<td>RAM</td>
<td>8GB</td>
</tr>
<tr>
<td>Networking</td>
<td>100 Mbps Ethernet</td>
</tr>
<tr>
<td>Video resolution</td>
<td>1600x1200, 1680x1050, 1920x1200, 1920x1080; 65K colours</td>
</tr>
<tr>
<td>Hard drive</td>
<td>500GB</td>
</tr>
<tr>
<td>Physical Hardware</td>
<td>Dell T5820XL Tower Workstation</td>
</tr>
</tbody>
</table>

2.2 ENTIS as a Client (User Interface)

Table 2-2: ENTIS as a Client

<table>
<thead>
<tr>
<th>System Configuration</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Single Intel Processor i3-4330, 3.50GHz (or equivalent)</td>
</tr>
<tr>
<td>RAM</td>
<td>8GB</td>
</tr>
<tr>
<td>Networking</td>
<td>100 Mbps Ethernet</td>
</tr>
<tr>
<td>Video resolution</td>
<td>1600x1200, 1680x1050, 1920x1200, 1920x1080; 65K colours</td>
</tr>
<tr>
<td>Video Memory</td>
<td>512MB VRAM per channel</td>
</tr>
<tr>
<td>Hard drive</td>
<td>500GB</td>
</tr>
<tr>
<td>Physical Hardware</td>
<td>Dell OptiPlex XE2, OptiPlex 3040, Dell T5820XL Tower Workstation, HP 400G3 or equivalent</td>
</tr>
</tbody>
</table>

2.3 ENTIS as Server / Client on Panel PC

Table 2-3: ENTIS Server / Client on Panel
<table>
<thead>
<tr>
<th>System Configuration</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Single Intel i5-4300U, 1.9GHz Dual Core processor or equivalent</td>
</tr>
<tr>
<td>RAM</td>
<td>8GB</td>
</tr>
<tr>
<td>Networking</td>
<td>Integrated dual Gigabit Ethernet ports</td>
</tr>
<tr>
<td>Video resolution</td>
<td>1920x1080</td>
</tr>
<tr>
<td>Hard drive</td>
<td>Single 256GB (or larger) SSD</td>
</tr>
<tr>
<td>Physical Hardware</td>
<td>MZ-PPCT01- Experion Panel PC, Standard 19 inch</td>
</tr>
<tr>
<td>Operating System</td>
<td>Pre-installed Win10 Enterprise LTSC 2019 Build 1809</td>
</tr>
<tr>
<td>Cooling</td>
<td>Fan less design</td>
</tr>
</tbody>
</table>
3 SOFTWARE REQUIREMENTS

The following software is required for the successful installation of ENTIS.

- Experion HS R520.2 point release
  For access to the Experion software at https://process.honeywell.com, send a mail to HPSWeb@Honeywell.com

The ENTIS installation will fail if installed on any operating system other than Windows 10 Enterprise 2019 LTSC/Windows Server 2019 Standard or in any environment other than Experion HS

3.1 Prerequisite Software

ENTIS must be installed on a system where Experion HS R520.2 point release is already installed and configured.

Go to: Experion-HS-R520-Software-Download-Datasheet.pdf

Table 3-1: Software requirements

<table>
<thead>
<tr>
<th>ENTIS Server and/or Client</th>
<th>Software</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Operating System</td>
<td>Microsoft Windows 10 Enterprise 2019 LTSC (64bit)/Windows Server 2019 Standard (build 1809)</td>
</tr>
<tr>
<td></td>
<td>Browser type</td>
<td>Microsoft Internet Explorer 11</td>
</tr>
</tbody>
</table>

3.2 Antivirus Software

ENTIS R130.2 is qualified with McAfee Endpoint Security (ENS) v10.7, as is qualified and supported by Honeywell for use by Experion PKS.

Please follow the steps in the document Antivirus Software Guidelines, XXDOC-X588-en. The document contains the instructions to install McAfee ENS 10.7.

Note that Honeywell has tested and qualified the Threat Protection feature of McAfee Endpoint Security. Other features such as Firewall, Web Control, and Adaptive Threat Protection are not qualified for use on Honeywell systems. Do not install these features.
4 INSTALLATION OF ENTIS

4.1 Prerequisites

Administrator privileges.
Prepare PC hardware (Physical or Virtual machine) and complete below prerequisite installation using Experion HS manuals, Videos and ENTIS Manuals. Ensure the following applications are available in the system before installing ENTIS:

Experion HS R520.2
Experion HS R520.2 HMIWeb Update 5

To install Experion HS follow the instructions mentioned below:

1. Install: Win 10 Enterprise 2019 LTSC OS with License (Customer will receive the OS media/DVD from ACT/Softco via Sales Order).
2. Install: Language pack on the Windows OS to view ENTIS in Dutch, French, Italian, Spanish, Russian and Chinese Default Language for ENTIS is English.
   • Refer the below link for changing Win OS language:
   • https://support.microsoft.com/en-in/help/14236/windows-language-packs
3. Install: Experion HS R520.2 software + License (Customer will receive the media /DVD from ACT/Softco via Sales Order).
4. Install: Experion HS R520.2 HMIWeb Update 5
5. ENTIS R130.2 software + License (Customer will receive the media/DVD from ACT/Softco via Sales Order).

**ENTIS R121.2.1 or prior release license is not valid for R130.2, An updated license is required for ENTIS.**

ENTIS Installation and Configuration Manuals can be found at: https://process.honeywell.com/us/en/products/terminals/enraf-tank-gauging/entis-tank-inventory-system

6. CIU 888(s) to be connected, operating firmware version R210.1.
4.2 Backup and Restore of Experion HS data

4.2.1 BACKUP

Note: Take all these backups and save it in a folder.

1) Take Export of EMDB (Assets)
   Connect to System level or EMDB where assets are configured and take a backup of configured assets.

2) Copy all the HMI WEB display files in the Abstract Folder from the following location or from your customized location where you have saved the HMI WEB display files and copy them to a folder and save them on a USB drive or any other node that you are not formatting.
   C:\ProgramData\Honeywell\Experion PKS\Client\Abstract

3) Take Export Quick builder database.
   Reference from above Screen shot Open “Build Channels” and Export the QDB
Note: In case Export all field fails, take an export of individual fields.

1. Copy the DATA Folder Backup from Primary or Non-Redundant server. Follow these steps to take manual copy of DATA folder.
   - On the Primary Experion Server or Non redundant Server, log in as a user member of Product Admin and Administrator Launch an elevated command prompt and execute: `shheap 1 backup`.
   - Using Windows Explorer, navigate to "C:\ProgramData\Honeywell\Experion PKS\Server\data"
   - Select all files in the \data folder (make sure that no subfolders are selected) and hit CTRL+C to copy files.
   - Copy the selected files (without subfolders) on a removable drive (for example, in T:\primary_data)

Note: Backups are crucial files. Keep them secure since you won’t be able to recover the old data from them after they have been formatted.
4.2.2 RESTORE

1. Importing Assets on a new Installed System.
   Connect to system level, open "Configure Assets for This System," and Import the
   Exported assets here.

2. Restoring QDB Database
   - Open Configuration Studio and open Quick Builder database, as said in the
     above screen shot.
   - Just click on IMPORT and give the location where you have copied the
     exported database. (Import first xxx.HDW backup then Import xxx.pnt file)
   - Download the Channels, Controllers and Points.

3. Move the HMI web display files to the ABSTRACT folder in the new migrated node.

4. Restoring the server Database.

Injecting the real-time database on the freshly installed server.

- Make sure the freshly installed Experion Server (A or B) or non-redundant is not connected to
  the production network.
- On the freshly installed Experion Server, log in as a user member of Product Admin and
  Administrator
- Set the Experion Server to DataBase only.
- Attach the removable drive to the server, say the files are in T:\primary_data or copy the
  database to C:\Temp folder.
- Open an elevated command prompt and type: sysbld -restore T:\primary_data\data -y or
  C:\Temp\Primary_data (primary_data is a temporary name you can keep any name)
- Note that the extra \data does not exist as a folder but is required. Ignore any error produced
  by the sysbld command.
- Set the Experion Server to running.
- Verify that the server is running.

Restart the freshly installed server.

4.3 Migrating non redundant ENTIS R121.1 to R130.2

Prerequisites

- The user should have the CIU with the latest firmware (R210). Steps to
  update the firmware are mentioned in CIU Firmware Upgrade Manual
  (Part No. 4417596).
- Installed CIU R210 service tool to configure the database for ENTIS
  R130. Configuration steps are mentioned in CIU Configuration Manual
  (Part No. 4417584).
- License for ENTIS R130.2 and a license for CIU888 R210 with
  OPCUA.
In ENTIS R130.2 has changed entities and ways of communication with CIU. ENTIS R130.2 is only compatible with CIU R210.1.

Steps to migrate

1. Create Backups:
   a. ENTIS reports and Exported data
   b. Backup Experion Databases using EBR
   c. Alternative backup is a full server image
   d. Record all Alarm settings and point data ranges on the existing SCADA points, this will be needed to manually set again later.

2. Install ENTIS R130.2.
   a. Uninstall the previous version and then install the new version of ENTIS (see section 4.4).

3. Once the installation is complete, copy the ENTIS license to the appropriate folder location.
   a. The license file name should be like ENTISR130.lic.
   b. Place license in following path:
      C:\ProgramData\Honeywell\ENTIS\License.

4. Remove SCADA points from previous ENTIS versions
   a. Follow the steps in Section 10.6

5. Migrating to the latest R210 CIU888 Database.
   a. Launch the ENTIS Configuration Tool (from the Windows Start menu).
   b. Click the Upload Files button.
   c. Navigate to the CIU888 database .mdb file folder
      C:\Users\Public\Public Documents\Honeywell\CIU 888 Service Tool R210.1\Site Database\{actual site database name}).
   d. Once the .mdb file is validated, click the Configure button.
   e. Click the Migrate button and confirm the migration by clicking Yes.
   f. When the ENTIS database is successfully created, create the Experion point files by clicking Yes.
   g. Wait for the Success, Experion point files successfully created message.

6. Manually enter recorded set point and settings for alarms on SCADA points
   a. Using Experion Configuration Studio
   b. Upload all points in the system
   c. For each point
i. Set the alarms
ii. Set the data range

4.4 Migrating ENTIS R130.1 to R130.2

4.4.1 For Non-redundant Server:

1. Install Windows 10 Enterprise 2019 LTSC. In this process all the data will be lost, thus data must be backed up before installing a fresh OS. For backup, refer to Section b.
2. Install Experion HS R520.2 release and the HMI WebUpdate 5 patch.
3. Now Install Entis R130.2
4. Remigrate CIU database and create new points. Some points have been added and removed in this release. So, creating points is necessary.
5. Restore old Experion HS backup data provided in Section b. But restoring points will cause some old points to show up that were removed in current version, and these points will not update. For information on points that have been removed or added, please see the Software change notice document.

4.4.2 For redundant server:

On Back-up server or Server B

1. Open configuration studio and connect to system level. Start taking Experion backups according to the instructions in the manual.
2. Uninstall Entis (precaution: take a backup of Programdata>Honeywell>Entis).
3. Flash OS with respective version.
4. Install Experion HS 520.2 and update patches.
5. Import Experion HS backup if needed (Incompatible with R130.2 Entis).
6. Install Entis R130.2.
7. Restart the machine.
8. Server will be running as primary.

On Primary server or Server A

1. Uninstall Entis (precaution: take a backup of Programdata>Honeywell>Entis).
2. Flash OS with respective version
3. Install Experion HS 520.2 and update patches.
4. Import Experion HS backup if needed (Incompatible with R130.2 Entis).
5. Install Entis R130.2.
6. Restart the machine.
7. Server should run as backup.
8. Server should sync and perform failover (Ensure this server becomes primary).
10. Set up the file replication and replicate. (Cross check the Entis folder in Program data).
11. Entis DB migration and create points. (Caution: This will lose alarms and range settings in Points and use backup for update).

Note: Entis DB migration needs to be done only on primary server to get the latest R130.2 database.
Run Redundant bat file only on Server A and File replication yet to be setup.
IP address and Name Should be unique not same as previous.

4.5 Migration Redundant setup with Single Network

If a newer version of ENTIS becomes available, an operational redundant setup with a single network (H12), as commissioned according chapter 5.3 below, can be upgraded by performing the following steps.

Upgrade ENTIS on Server A

1. Stop the primary server
2. Stop the backup server
3. Uninstall ENTIS on server A
4. Install ENTIS on server A

Upgrade ENTIS on Server B

Prerequisites: Servers A and B are both stopped
1. Uninstall ENTIS on Server B (Backup Server)
2. Install latest version of ENTIS on server B (Backup Server)
3. Start Server A (Takes Primary role)
4. On Server A, launch the Configuration tool to perform migration of the existing database(s).
5. Answer Yes to the question “Do you want to create Experion point files?”
6. Start Server B (takes the role of Backup server)
7. Execute the instructions of Chapter 5.5 Configuring ENTIS for data synchronization

On a redundant backup server (ServerB), the commissioning of redundancy creates some configuration files which get removed by the uninstallation. Therefore, the commissioning needs to be repeated after having upgraded ServerA and ServerB.

8. Stop and reboot server B. or Manually start the Mosquitto service on server B.
9. Execute the instructions of Chapter 5.6 Configuring Station connections for Server Redundancy

4.6 Installing ENTIS as a Server

Perform the following steps to install ENTIS as a server in your system:

The installer application, .NET framework 4.8 and .NET Core 3.1 setup files are contained in the disc drive ENTIS R130 folder within the disk. ENTIS uses .NET framework 4.8 and .NET Core 3.1. If the appropriate framework version is not present in your system, the installer will install it for you. The restart of your computer is required following the installation of the .NET frameworks.

![Figure 1: ENTIS Setup](image)
1. Right-click the installer application **Setup** in the disk and run it as Administrator. The ENTIS – Install Shield Wizard appears.

2. Click **Next**. The License agreement screen appears.

3. Select the “I accept the terms…” option and click **Next**.
The Program Maintenance screen does not appear if you are installing ENTIS for the first time.

4. Click **Next**. The Custom Setup screen appears.

5. Select **ENTIS Server** and click **Next**. The Service account details screen appears.

   *If .NET framework 4.8 / core 3.1 is not present, ENTIS installer will only install when ‘ENTIS Server’ feature is selected for installation.*
6. Enter the Valid password for the ENTIS User account. Click **Next**.

7. Click **Install**.
A restart is required after the installation is completed.

After a successful installation, the Install Shield Wizard Completed screen appears.

The ENTIS Server application is successfully installed in your system as a server.
5 INSTALLING ENTIS WITH REDUNDANCY

Depending on the network topology, extra steps might be required. Please follow the directions of the chapter related to your network topology to implement ENTIS at your site.

- Non-redundant
- Non-redundant ENTIS hosting redundant CIU's
- Redundant with single network

5.1 Non-redundant

The next figure will show the topology of a non-redundant ENTIS connected to a non-redundant CIU 888.

![Non-redundant ENTIS topology](image)

**Figure 2: Non-redundant ENTIS topology**

No additional steps are required for redundancy. You can continue with chapter 6.
5.2 Non-redundant ENTIS hosting redundant CIU’s

The following figure shows the topology of ENTIS on a single server hosting a redundant pair of CIU’s 888.

Figure 3: Non-redundant ENTIS hosting redundant CIU’s topology

This topology does not require extra commissioning steps for ENTIS. You can continue with chapter 6.
5.3 Redundant with Single network

ENTIS redundant with single network is based on the topology.

Figure 4: ENTIS redundant single network topology

To commission ENTIS for the topology pictured above, the following steps need to be performed.

5.3.1 Prerequisites

Ensure the following:

- The host names of both systems comply with the rule for Experion HS. This means the host name of one system ends with the character “a” and the other with “b”.
- Ensure that both servers have Experion HS and ENTIS installed, are connected to the same network, and turned on.
5.3.2 Commissioning

Commissioning of redundancy starts with steps to commission Experion HS to support a single network. These steps need to be performed after having installed Experion HS and ENTIS.

The following sections describe the steps to configure the hosts file, define the arbitration and setup the data links between the servers.

Configure the host file

During commissioning of the Single Network Redundancy topology (Topology H12), see Figure 5, the hosts file need to be constructed according the following instructions.

In a single network configuration without Backup Control Center (BCC), both servers are connected on a single network and have a single network card installed. Figure 5 shows an example of a single network configuration.

![Figure 5: Single network configuration](image)

In this example the TCP/IP address of \texttt{hsserva} is 192.168.0.1 and the TCP/IP address of \texttt{hsservb} is 192.168.0.2. Add the following lines to the hosts files:

- # TCP/IP address for primary
- 192.168.0.1 hsserva hsserva0
- # TCP/IP address for backup
- 192.168.0.2 hsservb hsservb0
5.3.3 Configure arbitration

The Experion HS command prompt referred to in the next section can be located at: C:\ProgramData\Microsoft\Windows\All Honeywell tools\Server\Diagnostic Tools\Experion Command Prompt.lnk

The arbitration method to be used in your redundant server system must be defined for the primary and backup servers.

An example hardware definition file (which you can modify and use) is shipped with Experion HS. The file name is redun.hdw and is located in <data folder>\Honeywell\Experion PKS\Server\User\, where <data folder> is the location where Experion data is stored. For default installations, <data folder> is C:\ProgramData.

Prerequisites
- You must stop the Experion HS server before using the hdwbld utility.

To define the arbitration method
1. In any text editor, open or create your hardware definition file.
2. Add the following entry to the hardware definition file:

   DEL PSW00
   ADD PSW00 NETWORK_PSW RECOVER=recover_option
   IDLE=10 READ=15

   Where the recovery option is ABORT or REBOOT. ABORT means that when a failover occurs, Experion HS server service is stopped and restarted on the failed server. REBOOT (the recommended option) means that when a failover occurs, Experion HS server service is stopped and the database unloaded on the failed server. The Experion HS server service is then restarted.
3. Save the file and copy to the primary and backup servers.
4. Type the following:

   hdwbld filename.hdw

   where filename is the path and filename of the file you created in the text editor.
5. Repeat the above step on the backup server.

Example:
The following hardware definition file entries are for a redundant server system with software arbitration. When a failover to the backup server occurs, Experion HS is stopped and restarted on the primary server.

   DEL PSW00
   ADD PSW00 NETWORK_PSW RECOVER=ABORT IDLE=10 READ=15
Defining the data links
When the primary and backup servers are running in redundant mode, all database changes on the primary server are sent to the backup server via data link. (A data link is a network path between the primary server and the backup server.)
A hardware definition file must be created defining the data links. This file must be built individually on both servers (using the hdwbld utility).

The example hardware definition file <data folder>Honeywell\Experion PKS\server\user\redun.hdw also includes data link definition examples. Where <data folder> is the location where Experion data is stored. For default installations, <data folder> is C:\ProgramData. The C:\ProgramData folder is a system folder, which means that it is only visible if you select the Show hidden files, folders, and drives option button in the Folder Options dialog box. To change this setting in Windows Explorer, click Organize > Folder and search options, and then click the View tab.

To build the data link for a single network
1. Open a text editor such as Notepad.
2. Add the following entry to the file:
   DEL LNK00
   ADD LNK00 NETWORK_LINK
3. Save the file with a .hdw extension.
4. On the primary server, open the Experion HS Command Prompt window. To run Experion HS commands, you must be a member of the Product Administrators group. If you want to do engineering tasks, you must be a member of the Local Engineers group. You must run Experion HS commands from the Experion command prompt and not the standard Windows command prompt, otherwise you will not see the output from the command and the command will fail.
5. Type the following:
   hdwbld filename.hdw

where filename is the path and filename of the file you created in the text editor.

Performing step 5 will result in the system showing the following screen.
Figure 6: Experion Command Prompts
To start Experion server

1. Search for the “Start-Stop Experion PKS Server” application in the Windows Start menu and open it.

   If Experion is shut down, this app’s status will look like the following:

<table>
<thead>
<tr>
<th>Experion HS Server</th>
<th>—</th>
<th>☐</th>
<th>✗</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Server is stopped</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. Click on Start and select Yes.
3. Once the server is started, status will be The Server is running.

<table>
<thead>
<tr>
<th>Experion HS Server</th>
<th>—</th>
<th>☐</th>
<th>✗</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Server is running</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Start</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop</td>
</tr>
</tbody>
</table>
5.4 Configuring ENTIS for File Replication

In the redundant configuration for ENTIS, there are artifacts that must be synchronized between the redundant servers. ENTIS leverages the Experion File Replication service, which must be configured by following these steps:

- Open Honeywell Experion Station:
- Open the Windows Start Menu
- Select Honeywell Experion → Experion Station
- Log in as a user with Manager permissions
- Open the file replication configuration page in Station via the top menu bar
  CONFIGURE → File Replication

The ENTIS Installer will create the correct shared network folders, with the proper access permissions, for the replication service to work properly.

Select an empty row at the bottom of the list
The edit page will open

To Change the settings and fields, one must confirm each edit by pressing the “Enter” key.

1. Definition changes:
   - Name: EntisRepository
   - Path (will populate automatically to the created shared folder)
   - Select “Replicate files from this path”
   - Select “Postpone replication if files are in use by another application”

2. File selection changes:
   - Select “Include subdirectories”
   - Deselect “Overwrite existing files (even if newer)”
   - Select “Auto purge/mirror files”

3. Schedule changes:
   - Deselect “Replicate every day at”
   - Select “Replicate automatically whenever files change”

4. Destination changes:
   - Select “Specific PC’s”
   - Enter both PC names <servername>A and <servername>B
   - Confirm green indicator for both (when <servername>B is also running)

5. Click “Save”

6. Click “Replicate Now”
7. Confirm status “OK”

8. Go back to CONFIGURE → File Replication

9. Select “Send” box at the “EntisRepository” entry
This configuration must be repeated on the redundant server (<servername>B)
5.5 Configuring ENTIS for data synchronization

Prerequisites:

1. ENTIS on both Primary and Backup servers.
   - Includes the configuration and installation of Experion HS.
   - ENTIS installer will create the files and network shares with the right permissions.

2. Experion File Replication setup on both Primary and Backup servers.

To configure Redundancy features for ENTIS, do the following on the Primary server:

1. In Windows Explorer, Open the folder:
   <ENTIS install directory>\Redundancy

2. Locate “RunRedundant.bat” file
   - Double click the “RunRedundant.bat” file

   Script output:

3. Reboot the Backup server
5.6 Configuring Station connections for Server Redundancy

Stations need to connect to whichever server is running as the primary server. However, special Station configuration is required for local and network-connected Stations to locate and connect to the server running as primary.

Two options are available (both can be performed if needed):

1. Single screen stations without SafeView, continue to chapter 5.6.1.
2. Multi-screen stations with SafeView, continue to chapter 5.6.2.

When either (or both) are completed proceed to chapter 6.

5.6.1 Single-screen stations

To configure the station connections:

1. Start Experion Station on the Primary Server
2. On the top menu bar goto “Station”, “Connect…”
3. Select “Default”
4. → Edit Connection.. (opens connection properties window)

![Connection Properties - Default](image)

**Figure 7: Connection properties**
5. Type the server names separated by comma, in “Server(s)” followed by Enter (see Figure 7)

6. → Save as .. Default.stn → Save (Overwrite)

7. Close Experion Station on the Primary Server, Start Experion station on the Backup Server

8. Repeat steps 2..6 on the Backup server

5.6.2 Multi-screen stations using SafeView

For Redundant systems using SafeView to display multi windows over multiple screens, a special Station configuration is required using the supplied ENTISMultiScreen.stn file. This needs to be modified using a text editor to avoid file corruption.

To configure the station connections:

1. On the Primary Server
2. In Windows Explorer, navigate to
   C:\ProgramData\Honeywell\Experion PKS\Client\Station\ 
3. Open “ENTISMultiScreen.stn” with notepad
4. Scroll to “[Communications]”
5. Change “Connection Type” to “LAN”

   Figure 8: ENTISMultiScreen edit Connection Type

6. Scroll to “[LAN]”
7. Change “Hostname” Type the server names separated by comma

   Figure 9: ENTISMultiScreen edit Hostnames
8. → Save ENTISMultiScreen.stn
9. Repeat steps 2..8 on the **Backup** server

Continue with chapter 6
6 INSTALLING ENTIS AS CLIENT (USER INTERFACE)

Perform the following steps to install ENTIS as a Client or User Interface in your system.

For Client/User Interface only, not for Server use.

1. Right-click the installer application Setup in the disk and run it as Administrator. The ENTIS – Install Shield Wizard appears.

2. Click Next. The License Agreement screen appears.
3. Select the “I accept the terms…” option and click **Next**.

*The Program Maintenance screen does not appear if you are installing ENTIS for the first time.*

4. In the **Custom Setup** screen, click the drop-down button to the left of **ENTIS Server** and choose the **This feature will not be available** option.
5. Select the option **ENTIS User Interface**.

6. Click **Next**.
7. Click **Install**.

After a successful installation, the **Install Shield Wizard Completed** screen appears.

The ENTIS application is successfully installed in your system as a client.

To configure the client's station connection.

1. Open Experion station, select **STATION** on the top menu bar

2. → Open Connection Properties (opens the connection properties window).
In the properties Window.

1. In **Server(s)**, enter the server name (or comma separated list in case of redundant servers) or IP address.
2. Select Station 2 or another station other free station.
3. Press **Save** and Connect.

With this configuration, the client station connects to the server defined in the Default.stn.
7 INSTALLING ENTIS ON PANEL PC

Perform the following steps to install ENTIS as Server/User Interface on Panel PC:

Panel PCs have pre-installed Windows 10 Enterprise 2019 LTSC operating system.

1. Perform steps 4 and 5 from section 4.1 procedure to install Experion HS 520.2.
2. Select the preferred option for ENTIS Server/ENTIS User Interface.
3. Click Next.
4. Follow the same steps from the previous procedure to complete the installation of ENTIS as a Server/Client on Panel PC.
5. Follow the procedure described in section 5.6 for configuring station connections using PanelStation_Default.stn

New Station (PanelStation_Default.stn), .xml (DisplayGroupLinks.xml) .stb (PanelStation_Default.stb) files are provided to accommodate ENTIS Panel PC Station view.

Station View for panel PC
8 Changing Language

8.1 ENTIS and Experion HS server

Perform the following steps to change ENTIS and Experion language to Dutch, French, Italian, Chinese, Russian or Spanish. Only the Administrator can change it during ENTIS installation.

1. **Operating System (OS):** Install Language Pack in your Windows OS first as mentioned in Prerequisites above.

   **Note:** For Unicode characters, Install "Arial Unicode MS". This font is required in Reports for Chinese characters. To install this font, Right click on the downloaded font (.ttf) and click "Install for all users".

2. **ENTIS:** Browse to the path - C:\Program Files (x86)\Honeywell\Entis\Localization and execute the batch file RunChangeLocale.bat.

   This will change ENTIS and Experion HS language to the system’s Windows OS language.

   **Experion:** The default language is English.


   To start Experion server:

   1. Search for the "Start-Stop Experion PKS Server" application in the Windows Start menu and open it.

      If Experion is shut down, this app’s status will look like the following:

      ![Experion HS Server stopped](image)

      2. Click on **System Running** and select **Yes**.

      Once the server is started, **System Running** will be selected.

      ![Experion HS Server started](image)

   **Note:** Administrator should make sure that the site is not in full operation before executing the batch file for language change.

8.2 Experion HS Client
Perform the following steps to change Experion HS Client language to Dutch, French, Italian, Chinese, Russian or Spanish. Only the Administrator can change it during ENTIS installation.

1. **Operating System (OS):** Install Language Pack in your Windows OS first as mentioned in Prerequisites above.

2. **ENTIS:** Browse to the path - C:\Program Files (x86)\Honeywell\Entis\Localization\ExperionHS and execute the batch file `RunChangeEPKSLanguage.bat`.

   This will change Experion language to the system's Windows OS language.

**Note:** ENTIS client language will remain same as ENTIS server.

**Experion:** The default language is English. For more information please find in the links below:


9 Verifying successful installation

Perform the following steps to ensure that ENTIS is successfully installed in your system.

On the Entis server machine
1. Open the Start menu.
2. Type “Control Panel”.
3. Select Programs and Features.
4. Find 'Entis'. The version number should start with 130.2.

1. Open the Experion Station, ENTIS splash screen should open directly as shown below.

2. ENTIS appears on the main menu of the Experion Station as shown below.
You have verified that the ENTIS application has been successfully installed in your system.

Check installed ENTIS Version.
10 CONFIGURING THE ENTIS SYSTEM IN EXPERION

Configuring ENTIS means to customize the Experion server database for your plant. It involves defining communication connections, and the data acquisition and control that you want to implement at your site.

ENTIS is configured according to the end user requirements using Configuration Studio, which is installed as a part of the Experion installation.

10.1 Starting Configuration studio

Prerequisites
You must have an Experion operator account on the Experion server to which you want connection.

If this is a new installation, use the default mngr account.

To start the Configuration Studio:

Perform the following steps to start Configuration studio:

1. Choose Start > All Programs > Honeywell Experion PKS > Configuration Studio.
2. Log on to Configuration Studio.

The login prompt is only displayed if the account used to log on to Windows is not configured as an operator either directly or via Windows group membership, that is, if your system is not using single sign on. If single sign on is enabled, you do not need to enter a name or password or select a domain name.

a. Type the operator name and password.

b. In the Domain list, select one of the following:

<table>
<thead>
<tr>
<th>If...</th>
<th>Select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>The operator name is maintained in a Windows domain</td>
<td>The Windows domain name</td>
</tr>
<tr>
<td>The operator name is maintained on the server or system that you are connecting, and you use integrated security</td>
<td>Servername (the target)</td>
</tr>
<tr>
<td>You are using traditional operator security</td>
<td>&lt;Traditional Operator Security&gt;</td>
</tr>
</tbody>
</table>

c. Click OK.
The Configuration Studio window appears.

3. Go to File > Connect to open the Connect dialog box.
   a. Connect to Experion System (not to Experion Server)
4. In the Connect dialog box, click Other Targets tab.
5. In the Target Type drop down box, select Experion System.
6. In the Target Name text box, type localhost
   Alternatively, you can specify the IP address of the server.
7. Click Connect.
Select a system when you want to configure your asset model, configure your Network tree, or select a server for specific tasks.

d. Select the option under **Server Tasks** to add a server to this system.

e. Enter **Alias** (*ENTIS Server*).

f. Enter **Description** (e.g., *ENTIS R130 Server*).

g. Enter **Node Name**: Enter the name of the PC here (ENTISSVR).

h. Click **OK**.
For Redundant Servers, enter the Node Name as PC name without the A or B (e.g. ENTISSVR or SERVER and also check/enable Redundant?). At this time ENTIS is only network type of single/FTE.

i. Click Yes.

j. Click Continue.
k. Click **OK**.
8. Results: Configuration Explorer is populated with a tree of items that you can configure for your system as shown below.

10.2 Configuring Assets

Assets are items that make up the asset model.

Prerequisites
You have a security level of ENGR or higher. See Refer to ENTIS User’s Guide, ETDOC-615-en-R130.2, see Documentation References

- You have launched Configuration Studio and connected to an Experion system.
- Configuration Studio should be connected in system mode to add the server.
- Once the server is added, you can add assets to it by connecting Configuration Studio in system mode.
- You can only configure assets within an Experion system.
- You have already configured the system and added servers to the system using Configuration Studio.
To configure assets:

1. In the **Configuration Explorer** in Configuration Studio, select the highest-level system node.

2. In the right pane, under **System Tasks**, click **Configure Assets for this system**.

3. The **Enterprise Model Builder - Asset** window appears. The left side of the window shows an Asset tree view containing the asset model structure.
4. If the Asset tree view window is not visible, click Open Tree on the toolbar to open the asset model.

5. Choose File > New ASSET. The ASSET Block Parameters dialog box appears.
6. In the Tag Name box, Enterprise Model Builder has already assigned a default tag name. Type a new unique tag name.

7. In the Item Name box, Enterprise Model Builder has already assigned a default item name. Type another item name, if you require a different item name.

8. In the Description box, type a description of the asset.

9. In the Point Detail Page and Associated Display boxes, type the name of the associated displays.

10. Select the Directly Assignable (for scope of responsibility and alarm enable/disable) check box if you want the asset to be assignable to an operator, Station, or alarm group. The icons for unassigned assets in the Asset tree view appear dimmed.

11. Click the Identification tab.

12. In the Block Comment boxes, type additional information about the asset.

13. Click OK to create the asset. The asset appears in the Asset tree view.

You can arrange assets within the asset tree view by the clicking on the asset icon, and then dragging and dropping the icon to the new location.
10.3 Loading Asset Model on to Servers in the System

The asset model can be loaded to servers that are configured as part of the Enterprise Model. The asset model can be loaded to the Experion server.

This operation loads the entire asset model to the selected servers. The entire model includes the system configuration and all defined items in the model, which includes the top-level asset and all assets groups associated with that item. Individual assets cannot be loaded; assets are loaded as a model.

Prerequisites

- You have a security level of ENGR or higher.
- A system model has been defined, consisting of at least one server.
- An asset model, have been defined.
- You have the Enterprise Model Builder window open with either an Asset tree view displayed.

During the load operation, assets and points may temporarily belong to unassigned items in the Alarm Summary display. The tree view on the left of the display may show an incomplete model. These conditions should clear once the download is completed. When you start the load process, all items of the Asset model and all configured servers selected for load are locked to other users. If the asset model to be loaded is already locked, an error is reported and the load operation is aborted. If any of the configured servers are already locked an error is reported and the load operation is aborted.
To load the asset model onto servers in the system:

1. In Enterprise Model Builder, choose Tools > Load Entire Model or click Load Entire Model on the toolbar. The Enterprise Model Builder - Load window appears.

2. In the Load column, select the check boxes of the servers that you want to download the asset to. Clear the check box of any servers that you do not want to load asset to.

3. If required, select the Force Load check box to allow the load to proceed even if the system name or repository name has changed.

4. Click OK to begin the asset or alarm group load to the selected servers.

If no servers are selected, the OK button is disabled.
The Loading Asset dialog box appears, showing the name of the top-level asset or alarm group that is being loaded. A progress bar shows the duration of the load operation.

Results
The load operation validates all server names of all the configured servers in the system, as well as the point and full item names of the asset model.

If the load operation is successful without detection of any errors or warnings, a load status of Complete appears.

If any errors occur during the load operation, correct the fault and then perform the load procedure again.

Use the online help manual to get more information about the page at any point of time within the application. Press F1 to access Online help.
10.4 Creating FLEX or Client Stations (Multi user)

You can create and configure more than one station using Quick Builder.

To create a Station using Quick Builder:

1. In the Quick Builder window tree view, click Stations. The Stations window appears.

2. In the Stations window, right-click and select the Add Items. The Add Items dialog box appears.

3. Type the number of items you want to create in the Number of items field. If you choose to create more than one item, extra fields appear where you can define the suffix applied to each item name. The variable used can be numbers of letters.

4. From the Item Family list, select the applicable family. If you used a template or a right-click menu option to invoke this dialog, this field will default to the template type or the item you had selected at the time.

5. From the Item Type list, select the item type.

6. In the Name text box, type in the name for this item, or you can accept the default provided. A summary of the details you have provided is displayed.

7. Click OK to add the item(s) to the list.

8. The new items appear in the List View.

9. Click the download button on the toolbar.

The Download window appears.
10. Click the **Download** button.
11. The **Results** message box will be displayed after successful completion of download.

12. Click **OK**
10.5 ENTIS Multi Screens Using SafeView

Multi-screen layouts are achieved using the Experion SafeView application. ENTIS comes with preconfigured workspace settings files that implement various screen layout configurations. The image below shows the window layout for each screen configuration.

![Screen Configuration Diagram]

The actual screen resolutions depend on the hardware that the system runs on and needs to be configured as per the following sections.

10.5.1 Change the resolution / Desktop Area pixels

Set the Desktop Area pixels / Monitor resolutions in the WDL files as per the Windows Display Resolution.

1. The WDL files can be found at: “C:\ProgramData\Honeywell\Entis\Experion MultiScreen Files”
   a. EPKS_Single_Screen.wdl
   b. EPKS_Dual_Screen.wdl
   c. EPKS_Dual_Screen_vertical.wdl
d. EPKS_Quad_1x4_Screen.wdl

e. EPKS_Quad_2x2_Screen.wdl

2. Find the resolution of your monitor(s) at Desktop -> Display Settings -> Display Resolution

3. For each WDL settings file,
   a. Open the file using notepad.exe or other text editor
   b. Navigate to the following lines:
      
      number xresolution = 1280; // Desktop Area pixels width(x)
      number yresolution = 1024; // Desktop Area pixels height(y)
   c. Update the pixel values of the Desktop Area pixels width(x) and height(y) resolution.

10.5.2 Verify the Settings

It is recommended that all steps in this Installation and Configuration Guide be completed before attempting to verify the SafeView configuration.

10.5.2.1 Open the SafeView Application

1. Open the Windows Start Menu
2. Select Honeywell Experion -> SafeView
3. Click on Load Workspace...
4. Browse to: C:\ProgramData\Honeywell\Entis\Experion MultiScreen Files
5. Select a WDL file
   a. Verify that all windows fit the desired screen configuration as dictated by the hardware of the customer.

10.5.2.2 Customize the SafeView Windows

The WDL files included with ENTIS are preconfigured to display certain Experion or ENTIS pages in each “window”. This can be changed to any page:

1. Use the >> button to make window active/ focus on respective window title bar. Note: Only one of the windows will have output focus.
2. On the Command Tool Bar
   a. Use ENTIS and Experion menu’s and open any page (eg Alarm, ENTIS Group View etc)

To Hide unwanted Windows, click on Hide Place Holder. E.g. to Go back to
from 4 to 3 Windows.

10.5.2.3 Exit Multi Screens

1. From Experion Station Select the Menu Station -> Exit.
2. From SafeView application menu -> Exit.

Note: Exiting SafeView will reset the customized page selections to the default screens installed with ENTIS.

10.6 Remove old tanks (and SCADA points) from Experion

1. Open Configuration Studio.
2. Select the ENTIS server you are working on.
3. In the left pane click on Control Strategy.
4. On the right side, under Equipment.
   a. Click on Build Equipment.
      b. Quick builder tab will open.
5. In the top toolbar click on Upload.
a. Select **All items in project.**

6. Wait for **Upload successful** popup.

b. Click **OK.**

a. Close this popup

7. On the left side, Select **Equipment.**
8. On the right side, find the tanks and equipment no longer needed
   a. Right click on the tanks you want to remove and select **delete**, or
      by pressing the delete icon from the toolbar.

The following popup message will appear:
b. Press OK.

9. Select the **Recycle Bin**, Select everything with Ctrl-A.
10. In the top Toolbar click **Download**.
   a. Select **Selected Items only** radio button.

b. Click **Download**.
c. Wait for **Upload successful** popup.

Press **OK**.

### 10.7 Settings Required in Experion

#### 10.7.1 Events in Experion

1. In Experion station go to menu configure → system hardware Server wide settings.
2. Uncheck **Disable writes via the Network API** check box in Server Wide Settings.

*The checkbox must be unchecked to be able to see ENTIS events in Experion station.*
10.7.2 Alarm sounds and levels on station

1. Navigate to CONFIGURE/Alarm & Event Management/Alarms.
   a. On the ALARM ENABLE tab, verify the ENTISASSET has a checkmark next to it (note, had to go back and enable a second time for sounds to work).
   b. On the Alarm APPEARANCE tab, check the Use these colors for points on displays box. Colors can be Edit as needed.
   c. On the ALARM PROCESSING tab, verify that Enable alarms server-wide is checked.
      i. Station alarms **Audible active time** and **Audible re-alarm time** may be edited as needed.

2. Navigate to Configure/System Hardware/Flex Stations.
   a. Click on the Station(s) listed under Flex station (e.g. Server Station, etc).
   b. On the GENERAL tab under Audible alarm section.
      i. Check/activate for **Activate for alarms**.
         1. Low priority, High priority, Urgent priority and Critical priority.
   c. Click on Assignment tab.
      i. Give ENTIS Asset Full access.
         1. This enabled alarming even when logged oper on the Station.

3. Navigate to STATION/Connection Properties…
Perform the Historization configuration before running the ENTIS Configuration tool and creating Scada points in Experion.

1. Set Experion to database mode
   a. Run the Start-Stop Experion PKS Server Application
   b. Select the Database only radio button
Figure 12: Set Experion to Database Only mode

2. In the Command Prompt:
   a. Run "sysbld -PRESERVE -FULL" the command
   b. Do not change any options until the **Slow History** option comes
   c. Enter the number of history points based on Tanks (# of tanks * 24). Eg. 100 Tanks * 24 = 2400

**Example:**
The number of Points have been increased to 2500 in the below sequence

```
Microsoft Windows [Version 10.0.14393]
(c) 2016 Microsoft Corporation. All rights reserved.
C:\Users\Admin>sysbld -PRESERVE -FULL
Server 16800 points data base building
System status is OFF-LINE
Memory is being initialized
PRESERVE - Database contents will be preserved.
RELEASE - 942
Are you sure you want to rebuild your database? (Y/N) Y
Do you want to rebuild EVERYTHING? (Y/N) Y
Slow history is configured to historigize 2000 points.
Enter required number of point parameters
(1 to 500000 are allowed, or <return> to leave unchanged)
2500
C:\Users\Admin>
```

4. The ENTIS configuration tool can be can now be run to migrate the databases and create the Experion SCADA points
Storage is in disk, care must be taken on the number of History parameters/interval of capture.

5. Change/delete the History parameters/interval in the Experion Station under History->History Assignment

Figure 13: History Assignment
11 MIGRATING CIU 888 DATABASE

ENTIS Database is created using CIU 888 Service Tool to perform a database export and then using the ENTIS Configuration Tool, migrated to ENTIS.

Please refer to the CIU Service Tool guide on required setup and instructions for creating and maintain a proper site configuration database.

Perform the following steps to migrate the CIU 888 database for ENTIS.

11.1 Migration using ENTIS Configuration tool

Perform the following steps to start the Configuration Tool:

1. Choose Start > All Programs > Honeywell Entis
   Right click on Configuration Tool

   The ENTIS Configuration Tool will appear

2. Press Upload Files.

3. Browse to the folder holding the CIU 888 .mdb files using the file dialog and select the CIU 888 .mdb you need to migrate.
4. Select the CIU 888 file(s) and press Open.

5. When all files are successfully loaded the **Migrate and Configure** buttons will be enabled.
6. Press the **Migrate** button.
7. When the next screen appears, the ENTIS database is ready and you will be asked if you also want to create Experion point files.

a. Press **No** if:
   i. Points have been created before for this version of ENTIS and nothing has changed in the CIU regarding tank names or the number of tanks.

b. Press **Yes** if:
   i. This is the first time migrating
   ii. A new major ENTIS version was installed
   iii. Language selection was changed
   iv. Tank names or number of tanks on site has changed

If there are previously created ENTIS Experion Points, any programmable Alarm settings for those points will be lost after this operation.
12. For each tank in the system a screen like the one below will appear and automatically disappear. 

Do not close the ENTIS Configuration Tool while the point files get generated.

13. When all point files have successfully been created, the following screen appears.
14. Press OK.

15. The application can now be closed by clicking X in the upper right corner.

**11.2 Sites where Experion channels and controllers are already present**

Special care needs to be taken when there are already controllers and channels configured (for devices and equipment not relating to ENTIS) prior to installing and configuring ENTIS. Controllers defined in Experion must be assigned an Item number, this could conflict with the automatically assigned ENTIS controller numbers.

**ENTIS database migration must be done prior to any other channels and controllers creation in Experion Configuration Studio (Quickbuilder)**

ENTIS does not read where the available item numbers start and immediately uses item numbers RTU00001 to RTU00008 (for up to 8 CIUs) to create channels and controllers for the CIUs configured in the system. These item numbers should be unused for ENTIS migration to work without any workarounds.

If prior work was done in Experion and these item numbers are no longer
available, then a workaround will have to be performed using Experion Configuration Studio to manually create channels and controllers for ENTIS.

Using Experion Configuration Studio, create the following manually:

1. Upload all items in the server to Configuration Studio
2. Under Channels create:
   a. Channel: CHAUSE1
   b. Description: Entis Channel
   c. Item number: CHN000<X>
      Replace "<X>" with the first available Channel number
3. Under Controllers create (for each CIU that does not exist):
   a. Name: <CIU name>
      Replace <CIU name> with the given name for each CIU
   b. Controller Channel Name: CHAUSE1
   c. Item number: RTU0000<X>
      Replace "<X>" with the first available item number
4. Download the configuration changes onto your Experion server
12 Configuring Secure Communication over OPC UA

ENTIS supports secure communication with the CIU888 over OPC UA using self-signed certificates. To enable secure communication, the Security Mode, and Security Level settings of the CIU888 OPC Server must be configured with values other than None. When the configuration is complete and sent to the CIU, the site database can be migrated to ENTIS with the ENTIS Configuration Tool.

ENTIS automatically generates a self-signed certificate to communicate with the CIU888. For ENTIS to successfully establish secure communication with the CIU888, the ENTIS self-signed certificate and the CIU888 server certificate need to be trusted by each other. This can be done with the following steps:

Administrator rights are required to access the directory where the certificates are located

1. Trusting the OPC server certificate on the ENTIS server machine:
   a. Move the certificate from
      C:\ProgramData\Honeywell\Entis\Communication\OPCUA\Certificates\EntisOPCUAClient\pki\rejected\certs
to
      C:\ProgramData\Honeywell\Entis\Communication\OPCUA\Certificates\EntisOPCUAClient\pki\trusted\certs

2. Trusting the OPC client certificate on the CIU:
   a. Login to the CIU888 Web portal and navigate to the CONFIGURE tab.
   b. Click on Manage Certificates under the OPC UA Self Signed Certificates header. The ENTIS self-signed certificate can be seen in the Rejected Certificate section.
c. Select the certificate and move it to the Approved Certificate section.
d. Click on Close and when prompted for a restart, click on Yes.
Once the CIU restarts, ENTIS will communicate with the CIU securely over OPC.

For Cyber Security reasons, ENTIS client certificate is valid for a period of 2 years, after which a new certificate will be generated. During this time communication will be lost and Events logs will indicate that the certificate has expired. The new certificate must be approved in a similar way.
13 SETUP EVENT LOGGING SETTINGS

In Experion station go to menu configure → system hardware → Server wide settings

Uncheck the Disable writes via the Network API check box in Server Wide Settings.

The checkbox must be unchecked to be able to see ENTIS events in Experion station.
14 INSTALLING THE ENTIS LICENSE

License file should be named ENTEGR130.lic and placed in the following path: C:\ProgramData\Honeywell\ENTIS\License.

The installer will create the folder, but the license file should be placed manually. The scanner will work only if there is valid license from the current build. When there is no valid license found in the path, ENTIS station will throw an error message as shown below.

![Image of INVALID LICENSE message]

*Installing the license is only required on the ENTIS server.*
15 SETTING UP THE PRINTER

15.1 Scheduled printer installation steps

Adding a printer

To enable printing, a printer accessible over a network should be added to Windows devices. This can be achieved by automatic discovery or by manually looking up the printer’s IP address.

Add printer through automatic discovery-

1. Navigate to Control Panel > Hardware and Sound > Devices and Printers > Add a printer

2. Select the printer from the available list of network printers.

Add printer via printer IP address-

1. Navigate to Control Panel > Hardware and Sound > Devices and Printers > Add a printer.
2. Click on ‘The printer I want isn’t listed’.
3. Select the 'Add a printer using TCP/IP address or hostname' option.

4. Enter the IP address to lookup the network printer manually. Click on 'Next'.
5. Insert the printer driver CD and click on ‘Have Disk’. Browse to the disk location and click ‘Ok’. The printer driver installation will proceed.
Granting printing permission to Entis User-

EntisUser should be granted printing access to the newly added printer for successful printing.

1. From Windows Menu, search and click on ‘Print Management’.

2. Click on All Printers.
3. Right click on the printer added earlier and select ‘Properties.
4. Navigate to the ‘Security’ tab and under the Group or usernames, click on ‘Add…’

5. Type in ‘EntisUser’ and click on 'Check Names'. It will autofill the EntisUser’s full name.
6. Click ‘OK’.

For print servers, running a 64-bit version of Windows, and supporting client computers running 32-bit versions of Windows, you must add x86-based drivers for each printer as well as the x64 bit.

You can add printer drivers that are up to 2 GB in size. You will not be able to back up printer drivers that are larger than 2 GB.

**Install printer drivers**

Ensure that you download and install the client printer drivers on your machine before adding them to the print server. You must test the drivers before being installed on the production server. Perform the following steps to install printer drivers:

1. Open **Print Management**.
2. In the left pane, click **Print Servers**, click the applicable print server, and then right click on **Drivers**.
3. Click **Add Driver**.
4. The "Add Printer Driver wizard" opens. Click **Next**.
5. Pick the processor architecture for the driver - x64 and click **Next**.
6. Click **Have disk** and locate the *.inf file associated with the driver.
7. In the printer driver selection box, you will see the printer driver name. Click **Next**.

8. Before clicking on **Finish**, verify what type of driver you are installing on the server.

9. Repeat the same procedure for the x86 driver.

10. Set driver isolation - by default it is set to "None". Change it to "Isolated" if you want this type of setup.

    **Note: Set desired printer as windows default.**

How to set default printer in Windows 10?

1. Open the Control Panel and go to the **Devices and Printers** section.

2. In the Printers section, right-click the printer you want to set up as the default. Select Set as the default printer.

    **Note: Ensure that the paper tray is set to A4 paper size.**

How to set the paper size to A4?

1. Settings also to be done in print driver.

2. Click **Start**, point to Settings, and then click **Printers**.

3. Right-click the appropriate printer, and then click **Properties**.

4. Click the Paper tab, and then click the paper size you want to use in the **Paper Size box**.

5. Click **OK**, and then close the Printers folder.

    **Note: Ensure print the test page on A4 paper.**

How to test the quality of paper?

1. Click on the Windows Start button.

2. Select Control Panel (or type "control panel" in the search bar).

3. Click **View devices and printers**.

4. Right click on the icon for your printer.

5. Select **Printer Properties**.

6. Click **Print Test Page**.
16 UNINSTALL ENTIS

You must have system administrator privileges to uninstall ENTIS. Perform the following steps to uninstall ENTIS:

1. Open the Start menu.
2. Type “Control Panel”.
3. Select Programs and Features to display Uninstall or change a program screen.
4. Select ENTIS app from the list to uninstall.
5. Click the Uninstall button that appears.
INDEX

A
ABOUT THIS GUIDE ........................................................... ii

C
Configuration Studio ...................................................... 39
Configuring Assets .......................................................... 41
Configuring ENTIS for data synchronization ................... 24
Configuring ENTIS for File Replication ............................ 21
Configuring Station connections for Server Redundancy ........... 25, 26

CONFIGURING THE ENTIS SYSTEM ................................. 39
Configuring Assets ...................................................... 41
Loading Asset Model on to Servers in the System ..... 45
Starting Configuration studio ..................................... 39
Copyright 2019 Honeywell ............................................... ii
CREATING FLEX OR CLIENT STATIONS ......................... 48

E
ENTIS – Install Shield Wizard ...................................... 9, 29
ENTIS as a Client .......................................................... 2

H
HARDWARE REQUIREMENTS ........................................... 2
ENTIS as a Client .......................................................... 2
ENTIS as a Server .......................................................... 2

I
INSTALLATION OF ENTIS ................................................... 5
.NET framework 4.7.2 framework ................................ 9
Installing ENTIS as Server ......................................... 7, 9
Prerequisites .............................................................. 5
Installing ENTIS as Client or User Interface ................. 29
Verifying successful installation .................................. 36
Installing ENTIS as Server ......................................... 7, 9
Installing ENTIS with Redundancy ................................ 13
Configuring ENTIS for data synchronization .......... 24
Configuring ENTIS for File Replication ....................... 21
Configuring Station connections for Server
Redundancy .......................................................... 25, 26
Non-redundant .......................................................... 13
Non-redundant ENTIS hosting redundant CIU’s ........ 14
Redundant with Single network ................................. 15
INSTALLING THE ENTIS LICENSE ................................. 65
Uninstall ENTIS program ............................................. 68

INTRODUCTION .............................................................. 1

L
Legal aspects ........................................................................ ii
Loading Asset Model on to Servers in the System ........ 45

M
MIGRATING CIU 888 DATABASE ..................................... 57

N
Non-redundant ............................................................... 13
Non-redundant ENTIS hosting redundant CIU’s ........ 14

Q
Quick Builder- Station ..................................................... 48

R
Redundant with Single network ..................................... 15
Commissioning ............................................................ 16
Configure arbitration .................................................. 17
Defining the data links ............................................... 18
Prerequisites .............................................................. 15
References ...................................................................... ii, iii, 41

S
Safety and prevention of damage ................................... ii
SETUP LOGGING SETTINGS ............................................. 64
SOFTWARE REQUIREMENTS ............................................. 4
Prerequisite Software .................................................. 4
Starting Configuration studio ..................................... 39
Support ............................................................................ iii

U
Uninstall ENTIS program ................................................. 68

V
Verifying successful installation ................................... 36